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1. Introduction
1.1 General
ViPlus™ is a fully featured Image capture, measurement, image enhancement and reporting tool. It enables direct connection 
to Vision Engineering cameras and adds remote control to the EVO Cam II, enabling full control of the camera and adding 
features such as focus stacking and shape detection.

1.2 Main features
1.2.1 Image capture

Image capture for documentation is quick and simple and can be adapted to meet a user’s requirements as follows:. 

• Save and recall camera settings for quick and repeatable operation

• Customise features to enable efficient operation

• Control cameras direct from a PC saving need to move between camera and computer

• Saved images can be reloaded for subsequent inspection and/or mark up.

1.2.2 Annotating captured images

Users are able to draw on a range of preloaded scalable icons, rulers and stamps keeping reporting professional and efficient. 
Similarly measurement is quick and simple, working over live or static images the user can select from: Line, Point, Ellipse, 
Circle, Arc, Curve, Rectangle, Polygon, Polyline, Cross. Selection of the correct point for measurement is made even easier 
with the ‘Anchor point’ feature that automatically detects and edge within a selected area. Measurement data is automatically 
tabulated for easy inclusion in inspection report.

• Display overlays and annotations over live images for quick and easy checking of details

• Compatible with DXF files for easy interface with CAD software for checking items against technical drawings
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1.2.3 Image processing

ViPlus™ enables users to see the unseen detail by the use of features such as selective thresholding, edge detection, colour 
and contrast control as well as many other digital filters.

Focus stacking also extends what is visible by artificially building layers of images to smartly display detailed images that 
would not otherwise be possible. Dynamic or fully manual, focus stacking is especially important at higher magnifications 
where depth of field would otherwise prevent this full view of the subject.

1.2.4 Advanced features

ViPlus™ has auto detect functions that search for features and creates a report in easily exportable formats. It can segment 
areas in an image for easy separation of features and automatically compare similar images to highlight differences 
regardless of orientation. 

Features specific to EVO cam II

• Remote control of camera settings including; Zoom position, focus position, internal and external lighting control, 
Exposure settings (Aperture, exposure time, gain), image flip, black and white image, save and load settings files and 
focus stacking. Enables user to work from a PC without the need to switch between PC and camera. Also allows a user 
to be remote from the camera in situations where users need to be protected from hazardous samples (radiation or 
biohazard) or samples that need to be protected from users (i.e. Pharmaceuticals)

• Focus stacking; Easy focus stacking enables the full depth of the subject to be seen clearly all at the same time. 
Dynamic and manual configuration for ease of use.

• Zoom and focus control; speed and position

• Illumination control – Ring-light, Sub-stage and external; brightness level and on/off

• Exposure control; Auto or manual
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1.3 User modes
The user modes for ViPlus™ are as follows:

• Administrator: When the software is run using the appropriate USB security dongle and the user logs in as an 
administrator, all of the software features (including calibration) are available

• User: When the software is run using the appropriate USB security dongle and the user logs in as an ordinary user, all 
of the software features (except calibration) are available.

• Reader: When working with this version here is no protection, it can only: open file, edit or create annotations.

• Demo: When running in the demo mode the software operates as follows: 
No function limit to main features 
Images are saved with a logo over the centre 
Calibration is not possible 
20 minute time limit before close down 
Warning displayed the software will close down the user’s computer if overused.

• Full screen mode: This mode is supported by the primary screen or the secondary screen (when used as a desktop 
extension).

1.4 Protection
ViPlus™ is protected by a ROCKEY4ND dongle attached to a USB port.
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1. Initial set-up
1.1 System requirements
The following are the minimum system requirements that will enable ViPlus™ to operate up to 18.3 frames per second  
refresh rate:

• Operating system Microsoft® Windows® 10 (64-bit)

• CPU type  Intel® Core™ i5 or i7

• Chipset  Intel H81 chipset, or equivalent 

• Display card  Dedicated video graphics card, capable of 1600x1200 with live video streaming,  
    or Intel HD4000 “on-board” video graphics card 

• Display resolution 1600x1200 (minimum 1280x960)

• Memory  At least 8GB 

• Disk space  200GB solid state hard drive - for installation, plus data and image storage 

• USB  USB3.0 ports

• Other  Windows-compatible mouse and keyboard

 i ViPlus™ does not support the 32 bit operating system.
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1.2 Installing the software

 X Insert the ViPlus™ USB stick supplied into your PC.

 X Navigate to the USB’s content and double click on the setup_viplus.exe file.

 X The ViPlus™ language selection screen will be displayed (Figure 1):

Figure 1: ViPlus™ run screen

 X Select the required language from the drop down list if necessary and click OK. The license agreement will be displayed.

Figure 2: License agreement

 X Agree to the agreement and click Next > to continue. Otherwise, click Cancel and the installation will be aborted.
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 X The ViPlus™ information screen will be displayed.

Figure 3: ViPlus™ Information screen

 X Read the information, click the Next > button and follow the instructions on subsequent screens until the Setup complete 
screen is displayed.

Figure 4: ViPlus™ installation wizard

 X Decide if the software should e launched and click Finish.

 X The USB stick can now be removed.
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1.3 Starting the software

 X Before starting the software, insert the licence dongle into a suitable USB socket on the PC.

 X Double click the ViPlus™ logo  on the PC’s desktop screen or a single click from the icon in the start menu. The 
password entry box will be displayed.

 X Select Administrator from the drop down list and enter the default password (admin).

Figure 5: Password entry box

 X Click login and the start-up screen will be displayed.

Figure 6: ViPlus™ start-up screen
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 X After the start-up screen has been displayed, the initial screen will be displayed.

Figure 7: ViPlus™ initial screen

 X Select the required language if necessary by clicking on Options in the menu bar and selecting the appropriate language 
from the Language drop down list .
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1. Selecting a camera
The following cameras can be used with ViPlus™ software:

• Mantis Elite Cam HD

• Smart Cam

• Smart Cam 5

• EVO Cam II (see 1.1 Evo Cam II on page 3 for details)

To use the above cameras, proceed as follows:

 X Plug in the USB from the camera to the PC

 X Select DirectShowCAM from the Video Device menu

 i The IDS Camera detected message may appear (see right and click OK)

 X A warning message will appear (see right). Click Discard or the camera image will not  
display properly.

 X Select the required camera from the drop down list (see right).  
Select UI155xLE-C for Mantis and Lynx Evo SmartCam 
Select UI358xLE-C for Lynx Evo SmartCam 5

 X In order to load .ini camera settings file supplied with systems press  button.

 X Select the Device tab and click Load Settings. (see right)

 i Other camera/image settings can be changed with this menu.
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1.1 Evo Cam II

 X Connect the EVO Cam II output to a USB port on the PC and turn the camera on.

 X Click on Video Device in the menu bar and then select the required camera from the drop down list. A configuration 
dialogue box will be displayed.

Figure 1:  Video device selection and configuration

 X Make any changes to the configuration settings if necessary and click OK. The camera’s control panel will then be 
displayed at the top of the screen below the menu bar.

 i The controls shown in Figure 2 are for the EVO Cam II but other cameras are supported by ViPlus software.

Figure 2: Camera control panel
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1.2 Common camera controls
1.2.1 Video On/Off

 These buttons turn the video on  or off .

 X Click on  in the camera control panel to display the camera’s image (see below).

Figure 3: ViPlus™ screen with video device image displayed

1.2.2 Display/overview

 This allows the display frequency (Hz) to be limited (i.e. 0 means no limitation). Limiting the refresh rate  
 can help when working with PC’s with lower performance.

1.2.3 Orientation

  Changes the display orientation with options of None, Horizontal only, Vertical only or both Horizontal  
  and Vertical.
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1.3 EVO Cam II controls
1.3.1 Zoom Speed

 This refers to zoom speed when Controlling EVO Cam II. 1 = slow movement accurate control.  
   7 = Fast movement coarse control.

1.3.2 Zoom

 Click on  to zoom out or  to zoom in.

1.3.3 Manual focus

 To manually adjust the image focus, click on the + or - . Alternatively, click on the slider and drag it until  
   the desired focus has been achieved.

1.3.4 Auto focus

  Click this button to auto focus the image.

1.3.5 Auto/Manual exposure

  Click on this button to switch between automatic and manual exposure. The status of the selection will be  
   displayed at the far right of the control panel.  

 Automatic exposure mode. 
 Manual exposure mode.

1.3.5.1 Manual exposure controls

When in the manual exposure mode, Click on button u to toggle between a colour 
and monochrome image. Drag slider v to adjust the iris. Drag slider w to adjust 
brightness. Drag slider x to adjust gain.

u v w x
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1.3.6 Cross on/off

  Click this button to display a small cross in the centre of the display image and click it again to turn the  
   cross off. The status of the selection will be displayed at the far right of the control panel.  

 Cross on mode. 
 Cross off mode.

 X Right click on the Cross icon to display the options menu (see right).

 X Use this menu to select:

• On/Off

• Size

• Colour

1.3.7 Illumination controls

 Click on either ringlight , substage , or external  to display the control slider. 

 Click and drag the slider to adjust the illumination level.

1.3.8 Focus stacking with EVO Cam II

 X Using the focus slider select start and end point of the focus range. If the subject is not within the range of movement, 
adjust the position of the camera and retry.

 X Decide on Custom or Dynamic focus stacking.

 X If Custom set the custom settings.

 X If Dynamic the camera will automatically determine the required settings
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1.3.9 Focus start/end

 Use the focus start  and focus end  icons to create a focus range.

1.3.10 Custom/dynamic focus

 The fixed focus icon  will generate a linear sequence up to a fixed number of images. The number  
   (default is 4) is defined with the Focus SEQ setting in Custom sequential focus control panel (see above). 
   The dynamic focus icon  will generate a linear sequence automatically, based on the camera settings,  
   up to a dynamic maximum image number in the range 3 to 32.

1.3.11 Multi focus

  This function stops live video and displays the final Multi focus image . This image is not automatically  
   saved, this can be done manually with standard ViPlus™ commands.

1.3.12 Custom sequential focus

 Once a manual focus position has been set, using either the Focus Slider (see 1.3.3 Manual focus on page 5 or  
  direct AutoFocus (see 1.3.4 Auto focus on page 5), the automatic sequential focus settings can be adjusted  
  once the START and END focus positions are defined (see above). Use the control  
  panel (see right) as follows:

 X Focus Sequence is used to adapt the number of fixed images in a sequence. The number  
can be in the range 3 to 32. The default setting is 4.

 X Focus Latency can be used to adapt the internal inter-focus delay as required by camera  
hardware/firmware and is used on the host PC. The default setting is 2.

 X Snapshot generates a single file of each image captured for focus stacking.

 X Del Snapshots deletes all generated snapshot files.

 X If Full Manual is selected, the Multi Focus function should be used (see above).
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1. Tools tab - Display settings
1.1 Display icons
The display section of the Tools tab contains the following icons:

Figure 1: Display icons

• u Full/original resolution (see below)

• v Fit screen (see 1.2.2 on page 3)

• w Results sheet (see 1.2.3 on page 3)

• x Grid (see 1.2.4 on page 4)

u

v
w

x

y

z
{

|

• y Alternative view (see 1.2.5 on page 5)

• z Scroll bars and status bar (see 1.2.6 on page 6)

• { Keyboard or camera control (see 1.2.7 on page 6)

• | Mouse tracking crosshair (see 1.2.8 on page 6)

1.2 Display settings
1.2.1 Full/original resolution

 X Click on this icon to display the camera’s image at full or original resolution.
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1.2.2 Fit screen

 X Click on this icon to automatically resize the camera’s image according to the window size.

1.2.3 Results sheet

 X Click on this icon to display or hide the measurement results sheet as required.

Using the results sheet

When any measurements are made using the measurement tools (see help file 05), analysis tools (see help file 06) or the 
watershed function (see help file 11), the results are placed in a table (see example below).

 X To change the name of the measurement (far left column), double click on the existing name and key in the new name.

 X To select a measurement object, left click the measurement in the table.

 X To arrange a column of measurements in the numerical order, click on the column header (e.g. perimeter).
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 X To create a CSV file, firstly select which separation character is required from the Char drop down menu (semicolon or 
comma). Then click Save CSV.

 X Clicking Copy CSV will place a CSV file into the clipboard. This can then be pasted into various spreadsheet programs.

 X Clicking Save XLS will create an Excel™ spreadsheet.

 X Clicking CSV XLS Edit displays a window that enables a previously saved CSV or XLS file to be loaded, edited 
and saved.

 X Click  to display a filter menu (see right) so unused columns can be removed from the table.

 X Right click on a row in the table to display the menu shown right. Use the menu to deselect any  
selected objects, select the object the row refers to, duplicate the row and measurement object or delete it.

 X Click Compact to reduce the table display to fit the table.

1.2.4 Grid

 X Click on this icon to display or hide the grid as required.

 i The grid colour and pixel pitch for width and height can all be altered by selecting Settings from  
	 the	Options	drop	down	list	in	the	menu	bar	(see	help	file	13	Settings).	The	grid	can	be	shifted	 
	 with	the	keyboard	(up,	down,	left,	right	arrow)	if	no	other	selection	is	active.
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1.2.5 Alternate view

 X Click on this icon to display or hide the alternate view as required.

 i The	alternate	view	has	it’s	own	scale	and	properties	(see	below).	

Using the alternative view
When the alternative view function is selected, a new window with a secondary view from the main active view is displayed.
(see below).

With this view you can change the scale to get more details from the main view. The settings of scale and software zoom 
are local to the alternate view window. All the Tools, Annotation and Measure tools are permitted in the Alternate View (and 
repeated in the main view).

With the mouse menu (see right) you can change how the mouse cursor is tracked in the main view. In Click  
mode the region of interest in the Alternate View is updated after mouse click. In Click&Move the region of  
interest in the Alternate View is updated after each mouse move. 

 i The Click&Move mode is not recommended during live video.  
In this case the paperclip icon is useful to temporary disable the Click@Move mode and switch to Click mode. 
The Alternate View is not allowed in Full Screen mode.
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1.2.6 Scrollbars and status bar

 X Click on this icon to display or hide the scrollbars and status bar as required.

1.2.7 Keyboard or camera control

 X With the keyboard icon displayed (left) the system is under camera control but when  
 clicked on, the keyboard control icon (right) is displayed.

Keyboard control

With keyboard control selected and in full screen mode (press F5 on the PC keyboard), the keyboard can be used as follows:

<UP>  Zoom+ (optical) 
<DOWN > Zoom- (optical) 
<LEFT >  Focus+ 
<RIGHT>  Focus- 
<END >  AutoFocus 
< F5 >         enter full screen mode 
< ESC >  exit the full screen mode 
< PAGE DOWN >  save the document 
< SPACEBAR >  switch the keyboard mode

1.2.8 Mouse tracking crosshair

 X Click on this icon to display or hide the mouse tracking crosshair.

 i The crosshair colour can be altered by selecting Settings from the Options drop down list  
	 in	the	menu	bar	(see	help	file	13 Settings).
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1. Tools tab - Measurement & notes
 i Accurate measurements can only be made after calibration (see help file 08 Calibration).

1.1 Measurement & notes icons
The measurement tools and notes section of the Tools tab contains the icons shown below:

Figure 1: Measurement icons

u
x

wv

• u Draw object types (see below)

• v Measurements (see page 11)

• w Delete

• x Annotation (see page 13)

1.2 Measurement & notes functions
1.2.1 Draw object types

 X Place the cursor over this icon to display the drop down list of object options (see right) .

 X The options are as follows:

Select
Click on this option and then click on an existing object . The object can then be deleted by clicking  
on the  icon .

 i When an object type is selected from the options menu, the measurement icon will change  
to reflect the object being created. For easy multiple actions of the same tool see 2.2.2 on page 21
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Line

 X Click and hold down either the left or right mouse button in the position on the camera image where you wish the line 
to start . Drag the mouse to the required end point and release the mouse button . The measurement length or angle is 
displayed adjacent to the line .

 X Click the left mouse button on the line to select it and then on either end point and drag it to a new position .
Line options

 X Placing the cursor over the appropriate line, click the right mouse button to display the Line options (right) .

• Distance1: The length of the line will be displayed adjacent to the line .

• Angle1: The angle clockwise from the highest end of the line to the horizontal will be displayed  
adjacent to the line .

• Angle2: The angle anticlockwise from the highest end of the line to the horizontal will be  
displayed adjacent to the line .

• No Arrow: The line has no arrow at either end .

• Arrow at End 1: The line will have an arrow at its end point .

• Arrow at End 2: The line will have an arrow at its start point .

• Arrow at Both Ends: The line will have an arrow at both ends

• Ortho on: When this function is selected the image is rotated so that features parallel with the line become 
horizontal on the screen .

• Ortho off: When the Ortho function is off, the camera’s image returns to normal .
Point

 X Click either the left or right mouse button to place a point at the cursor position on the camera image .
Anchor point

 X Click either the left or right mouse button to place a magnet point that is automatically positioned on a close border of an object .
Ellipse

 X Click and hold down the left or right mouse button and drag the cursor to create an ellipse from one point to another . 
Release the mouse button to finish the ellipse.

 X Click the left mouse button on the Ellipse to select it and then click and drag on the white points to change its size or on 
the red points to rotate it .
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Ellipse options

 X Right Click on the ellipse edge to display the measurement options (right) .

• Area: Displays the area of the ellipse .

• Perimeter: Displays the perimeter measurement of the ellipse .

• Radius1: Displays the radius of the largest part of the ellipse .

• Radius2: Displays the radius of the smallest part of the ellipse .

 X Double click the left mouse button on the ellipse edge to display the shape options menu (shown right) .

• None: No accompanying shape .

• Form Outer Circle: Forms a circle outside the ellipse with a diameter equal to the large diameter  
of the ellipse .

• Form Inner Circle: Forms a circle inside the ellipse with a diameter equal to the small diameter of the ellipse .

• Form Rectangle: Forms a rectangle outside the ellipse with its large edge being equal to the large diameter of 
the ellipse and its small edge equal to the small diameter of the ellipse .

Circle Centre Point

 X Click and hold the left or right mouse button to create a circle with its centre at the start point .

 X Release the mouse button to finish the circle with the desired radius.

 X To alter the size of the circle, select it (left click) and then click and hold the left mouse button on one the points and drag it 
to the required position .
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Circle

 X Click and hold the left button to create a circle from one point of the perimeter .

 X Release the mouse button to finish the circle with the desired diameter.

 X To alter the size of the circle, select it (left click) and then click and hold the left mouse button on one the points and drag it 
to the required position .

Circle 3 Points

 X Click three points with the left mouse key that describe the required perimeter of the circle . When the third point has been 
made, a circle will be created .

 X To alter the size of the circle, select it (left click) and then click and hold the left mouse button on one the points and drag it 
to the required position .

Circle options

 X Right Click on the circle edge to display the measurement options (right) .

• Area: Displays the area of the circle .

• Perimeter: Displays the perimeter measurement of the circle .

• Radius: Displays the radius of the circle .

• Distance: Displays the diameter of the circle .

 X Double click the left mouse button on the ellipse edge to display the extended options menu (shown right) .

• None: No accompanying shape .

• extract: Removes the surrounding area to leave only the selected area .
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Arc 3 Points

 X Click three points with the left mouse key that describe the required shape of the arc . When the third point has been 
made, an arc will be created .

Arc 3 Points options

 X Right Click on the arc edge to display the measurement options (right) .

• Angle1: Displays the internal angle

• Angle2: Displays the external angle

• Perimeter: Displays the perimeter measurement of the arc .

• Area: Displays the area of the arc .

• Radius: Displays the radius of the arc .

 X Double click the left mouse button on the arc edge to display the shape options menu (shown right) .

• None: No accompanying shape .

• Form Circle: Completes the arc into a circle .

• Form Rectangle: Forms a rectangle outside the circle with its sides equal diameter of the circle .

• Show Anchor Points: Displays a point at each end of the arc .

• Show points: Shows points at regular intervals around the arc .
Curve

 X Click the left mouse button to place a point at intervals following the curve that is to be formed .

 X When enough points have been placed, click the right mouse button to create the curve .

 X Click the right mouse button over the required part of the curve to insert another point .
Curve options

 X Double click the left mouse button on the curve edge to display the shape options menu (shown right) .

• None: No accompanying shape .

• Fit to Line: Generates a straight line of best fit within the shape of the curve.
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Rectangle

 X Click and hold the left mouse button and drag the cursor from the required start corner of the rectangle to the diagonally 
opposite corner and release the button .

 X To rotate the rectangle, select one corner (red dot) by clicking and holding the left mouse button over it, dragging the 
cursor to rotate as required and then release the mouse button . .

Rectangle options

 X Right Click on the rectangle edge to display the measurement options (right) .

• Area: Displays the area of the rectangle .

• Perimeter: Displays the perimeter measurement of the rectangle .

 X Double click the left mouse button on the rectangle edge to display the shape options menu (shown right) .
• None: No accompanying shape .

• Form Inner Circle: Forms a circle in the centre of the rectangle with a diameter equal to its  
smallest side .

• Form Outer Circle: Forms a circle on the outside of the rectangle that touches each of  
its corners .

• imageMatching: The sub image (of the reference image) defined by the rectangle is searched in the entire image 
and any matches are highlighted .

• Image Match: Creates a separate file in the PixMap format which can be used for comparison with other images 
or other parts of the same image .

• snapImageSelection: Working on the reference image, the sub image defined by the rectangle is saved into a 
new file. Save image dialog box is open. For instance this image can be used later with the comparison function.

 i The file extension must be correctly written.

• SnapImageMatchSelection: Working on a PixmapItem object, the sub image defined by the rectangle is saved 
into a new file. Save image dialog box is open.

 i File extension must be correctly written.

•  Transfer to Image Match: Creates a separate file in the PixMap format which can be used for comparison with 
other images or other parts of the same image .
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Polygon

 X Click the left mouse button to place a point at intervals following the required polygon shape .

 X When enough points have been placed, click the right mouse button to create the polygon .

 X To add more points, right click on the required position . To remove points, hold the Ctrl key down and right click on the 
point to be removed .

 X To move the position of an existing point, left click and drag the point to the required position .
Polygon options

 X Right Click on the polygon edge to display the measurement options (right) .

• Area: Displays the area of the rectangle .

• Perimeter: Displays the perimeter measurement of the rectangle .

 X Double click the left mouse button on the polygon edge to display the shape options menu (shown right) .

• None: No accompanying shape .
• Fit to Circle: Forms a circle of best fit to the points of the polygon.
• Fit to Rectangle: Forms a rectangle around the polygon that touches the polygon’s furthest corners .
• Fit to Curve: Forms a curve within the polygon .

Poly Line

 X Click the left mouse button to place a point at intervals following the required ploy line shape .

 X When enough points have been placed, click the right mouse button to create the poly line .

 X To add more points, right click on the required position . To remove points, hold the Ctrl key down and right click on the 
point to be removed .

 X To move the position of an existing point, left click and drag the point to the required position .
Poly Line options
The poly line can only display the length of the line (perimeter) .

• Fit to Line: Generates a straight line of best fit within the shape of the poly line.

• Fit to Rectangle: Forms a rectangle around the poly line that touches its ends .

• Fit to Curve: Forms a curve within the poly line .
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Cross

 X Click and hold the left mouse button and drag the cursor from the start point of the cross and release the button when the 
required cross size is reached .

 X To rotate the cross, select one corner (red dot) by clicking and holding the left mouse button over it, dragging the cursor to 
rotate as required and then releasing the mouse button .

 i The length of the vertical portion of the cross will be displayed. To display the horizontal length, place the cursor 
over the appropriate arm.

1.2.2 Measurements

This function allows various measurements between selected objects .

 X Place the cursor over this icon to display the drop down list of measurement options (see right) .

 X The options are as follows:

Select
Before two objects can be used for a measurement, they have to be selected .

 X Click the left mouse button over he first object to select it. Now hold the Ctrl key and use the left mouse to select the 
second object . Alternatively, if there are multiple objects drawn, press Ctrl A to select ALL . To select multiple objects 
drawn in an area, hold down the Ctrl key and select the desired area by clicking and dragging the left mouse button .

Distance
This function measures the distance between two points, the centre point of two lines or between a point and the centre point 
of a line .

Angle
This function measures the angle between two lines .

Circle
This function forms a circle between multiple points and/or centre points of objects .
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Projection
When two lines are selected: This function finds the middle of one line and draws a line perpendicular to the intersection 
point with the first line selected. Where the intersection point would be beyond the end of the first line selected a projection 
of the line is used .

 i The order in which the lines are selected determines the target line and centre point used.

When a line and a point are selected: This function draws a line perpendicular to the target line from the point . Where the 
intersection point would be beyond the end of the target line a projection of the target line is used .

 i The point must be highlighted first for the function to operate.

When a Line and a Circle or Ellipse are selected the function draws a line perpendicular to the target line from the centre of the 
Circle or Ellipse . Where the intersection point would be beyond the end of the target line a projection of the target line is used .

Intersection
This function places a point at the potential intersection of the following: line to line, line to circle and line to ellipse .

Tangent
This function generates points on a circle where a line extended from a point, the centre of a line, or another circle would 
touch the original circle tangentially .

 i For ‘Centre point’ and ‘3 point circles’ the tangent will be drawn from the edge of each circle. To draw a tangent 
from the centre of a circle to the outside of another circle, one must be created using the ‘Circle’ function. The 
points will then be placed at the tangent of the first circle selected from the centre of the second.
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1.2.3 Annotation

This function allows various annotations to be added to the display .

 X Place the cursor over this icon to display the drop down list of measurement options  
(see right) . The options are as follows:

Select
Use this function to select an existing annotation so it can be edited .

 X Click the left mouse button over the Select option and then on the object to select it for editing .

Text
To add text to the display, proceed as follows:

 X Click the left mouse button over the Text option and then over the position you require for the text . A small box will be 
displayed .

 X Double click on the centre of the box and the text entry window will open .

 X Click on the text entry area u and enter the required text .

 X To change the characteristics of the text, highlight the text by dragging the mouse over the text  
with the left mouse button down .

 X Use the text characteristics panel v to alter the appearance of the text as required .

 X Click OK to place the text in place of the original box or click Cancel to abort .

 X With the text placed on the display, it can be moved or rotated by clicking on it with the left mouse button .

 X To move the text once it is selected, click and hold the left mouse button on the centre of the text and drag it to the 
required position .

 X To rotate the text once it is selected, click and hold the left mouse button on the appropriate red corner and rotate the text 
as required .

v

u
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Arrow
To generate the type of arrow shown right, proceed as follows:

 X Click the left mouse button over the Arrow option then click and hold the left mouse button where the  
tail of the arrow is to be and drag the cursor to the position for the head of the arrow and release  
the mouse button .

 X To change the length or angle of the arrow, click on it with the left mouse button to select it then click on the point at the 
appropriate end of the arrow and drag it to the required position .

Arrow2
To generate the type of arrow shown right, proceed as follows:

 X Click the left mouse button over the Arrow2 option then click the left mouse button to place a vertical  
arrow in position .

 X To change the size or angle of the arrow, click on it with the left mouse button to select it then click on a white point and 
drag it to change the size, or click and drag on a red point to rotate it .

 X To change the position of the arrow, click on it with the left mouse button to select it and then click on the centre of the 
arrow and drag it to the required position .
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Smiley
To place a graphic on the display, proceed as follows:

 X Click the left mouse button over the Smiley option, click the left mouse button on the position required for the smiley and 
then select the required graphic from the drop down list . The selected graphic will be placed on the display .

 X To alter the smiley when it has been created, click on it with the left mouse button to select it and then  
click the right mouse button to display the edit menu (see right) . Select the required size or transparency  
as appropriate .

 X To manually change the size of the smiley, select it and then click and drag on either of the red points to  
change its size or click in the centre and drag it to the required position .

Insert image
To insert a stored image on the display, proceed as follows:

 X Click the left mouse button over the Insert image option and click the left mouse button on the position required for the 
image. The load file window will be displayed.

 X Browse to the required folder if necessary, select the image to be inserted and click OK to display the image or  
Cancel to abort .

 X To alter the image when it has been created, click on it with the left mouse button to select it and then  
click the right mouse button to display the edit menu (see right) . Select the required size, transparency  
or image compare as appropriate .

 i Image compare highlights the differences between the live image and the inserted image.

 X To manually change the size of the image, select it and then click and drag on either of the red points to  
change its size or click in the centre and drag it to the required position .



16

Magnifying glass
To magnify an area of the display, proceed as follows:

 X Click the left mouse button over the Magnifying glass option and click hold and drag the left mouse button to cover the 
area of the display to be magnified.

 X To change the size of the magnifying glass, select it and then click and drag on either of the red points to  
change its size or click in the centre and drag it to the required position .

 X To change the magnification, click on it with the left mouse button to select it and then click the right mouse  
button to display the lens menu (see right) .

 i The lower the lens number the higher the digital magnification applied.

Ruler
To place a ruler on the display, proceed as follows:

 X Click the left mouse button over the Ruler option and click the left mouse button to place the top left corner of the ruler at 
the position to be measured .

 X To change the size or angle of the ruler, click on it with the left mouse button to select it then click on a white point and 
drag it to change the size, or click on a red point and drag it to rotate the ruler .

 X To change the position of the ruler, click on it with the left mouse button to select it and then click on the centre of the ruler 
and drag it to the required position .

 X To change the scale of the ruler, click on it with the left mouse button to select it and then click on it with the  
right mouse button . The scale menu will be displayed (see right) . Click on the preferred value to select it .
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Stamp
To place a stamp depicting a linear measurement on the display, proceed as follows:

 X Click the left mouse button over the Stamp option and click the left mouse button to place the stamp at the  
required position .

 X To change the size of the stamp, click on it with the left mouse button to select it then click on a white point and drag it to 
change the size and the displayed measurement .

 X To change the position of the stamp, click on it with the left mouse button to select it and then click on the centre of the 
stamp and drag it to the required position .

 X To set the length also right click & select Value box . The value box opens (see right) . 

 X Insert the desired value and click OK to adjust the stamp or Cancel to abort .

Protractor
To place a protractor on the display, proceed as follows:

 X Click the left mouse button over the Protractor option and click the left mouse button to place the protractor at the  
required position .

 X To change the size of the protractor, click on it with the left mouse button to select it then click on a white point and drag it 
to change the its size .

 X To change the angle of the protractor, click on it with the left mouse button to select it then click on a red point and drag it 
to rotate it .

 X To change the position of the protractor, click on it with the left mouse button to select it and then click on the its centre 
and drag it to the required position .

Horizontal line
To place a horizontal line on the display, proceed as follows:

 X Click the left mouse button over the Horizontal Line option and click the left mouse button to place the line at the  
required position .



18

Horizontal line options

 X Click the left mouse button on the horizontal line to select it then click the right button on it to display the  
options menu (see right) .

 X Click the Auto Centre option to position the line in the centre of the display .

 X Click the Set Position option and key into the window shown right the required absolute position using  
the currently set units . Click OK to move the line or Cancel to abort .

 X Click the Set Pixel Position option and key into the window shown right the required absolute position  
using the position in pixels . Click OK to move the line or Cancel to abort .

 X Select the Markers option to have marker units added to the line .

Vertical line
To place a vertical line on the display, proceed as follows:

 X Click the left mouse button over the Vertical Line option and click the left mouse button to place the line at the  
required position .

Vertical line options

 X Click the left mouse button on the vertical line to select it then click the right button on it to display the  
options menu (see right) .

 X Click the Auto Centre option to position the line in the centre of the display .

 X Click the Set Position option and key into the window shown right the required absolute position using  
the currently set units . Click OK to move the line or Cancel to abort .

 X Click the Set Pixel Position option and key into the window shown right the required absolute position  
using the position in pixels . Click OK to move the line or Cancel to abort .

 X Select the Markers option to have marker units added to the line .
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Circle
To place a circle on the display, proceed as follows:

 X Click the left mouse button over the Circle option and click left mouse button and drag the mouse to create a circle of the 
required size .

 X To alter the size of the circle, select it (left click) and then click and hold the left mouse button on one the points and drag it 
to change the size as required .

 X To alter the position of the circle, select it (left click) and then click and hold the left mouse button n its centre and drag it to 
the required position .
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2. Settings fonts and layers
2.1 Settings fonts and layers icons
This section of the tools tab contains the icons shown below:

Figure 2: Setting fonts and layers icons

• u Lock/unlock zoom and focus (see below)

• v Repeat drawing mode (see page 21)

• w Object characteristics (see page 21)

u

w

x y

z

v

• x Font selection (see page 22)

• y Layer control (see page 22)

• z Lock/unlock objects (see page 22)

2.2 Settings fonts and layers functions
2.2.1 Lock unlock zoom and focus

 X This function is used to lock access to the zoom and focus controls of the selected camera . 

 i This is used to prevent changes to the image which would affect calibrated measurements.
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2.2.2 Repeat drawing mode

When drawing objects (see page 4) it is often useful to be able to draw multiple objects of the same type 
without having to reselect them . 

 X Select the object type that is to be created multiple times (e.g.Line) and then click this icon before the first 
line is drawn . The icon will now be displayed as shown right .

 X Multiple objects of the same type will now be created until the icon is clicked on again .

2.2.3 Object characteristics

Use this function to change the characteristics of objects created in the drawing mode (see page 4)

 X Place the cursor over the icon to display the characteristic options shown right .

 X Click on u (the current settings will be highlighted) and select the required outline thickness .

 X Click on v to select the outline type (dotted, etc .) .

 X Click on w to select the object colour .

u v w
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2.2.4 Font selection

Each object with a calculation or measure uses 2 types of font:

• Main font:  defines the font for the main measurement.

• Secondary font: defines the font for the secondary measurement.

 X Select the object that requires the font settings altered .

 X Click on the font selection icon and the font selection options will be displayed (see right) .

 X Select the required font type to alter . The font settings window will be displayed  
(see right) .

 X Select the required font, style, size, effect and writing system (language style), and  
click OK to make the changes the selected font or Cancel to abort .

2.2.5 Layer control

Each objects is created in a different layer . The last object created is on top layer . When several objects are 
overlapped, the mouse selection of an object on bottom layer might be difficult. To move objects down or up 
through the layers, proceed as follows:

 X Select the object that is to be moved to a different layer and click on the layer control icon .  
The layer options dialogue box will be displayed (see right) .

 X Click u to move the selected object to the bottom layer, v to move it to the top, w to  
move it up one layer, x to move it down one layer and y to close the dialogue box .

2.2.6 Lock/unlock objects

Objects are automatically unlocked when they are created (except for DXF Objects) .  
Unlocked objects can be edited or modified whereas locked objects cannot. Each object or  
group of objects can be put in the locked u or unlocked v state .

uv

w

x

y

u v
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1 . Image	analysis	and	filters
1 .1 Image	and	analysis	and	filters	icons
The image analysis section of the tool tab contains the following icons:

Figure 1: Image analysis and filters icons

u

x
v

w

• u Shape detection (see below)

• v Image Processing (see page 4)

• w Crop (see page 6)

• x Threshold settings (see page 4)

1 .2 Image	and	analysis	and	filters	functions
1 .2 .1 Shape	detection

 X Click on the shape detection icon to display its drop down menu (see right). 
 The options are as follows:
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Circle

 X Click on this option to automatically detect and create circle(s) on the image. This performs the same function as 
the Circle	Centre	Point option when created using the manual toolbox (see the 05	Measurement	Tools help file), 
measurements are made in real time and objects can be edited immediately after creation.

Circle	shapes

This finds shapes that approximate a circle.

 i The	parameters	that	affect	the	circles	that	are	detected	are	in	the	pop-up	menu	(see	right)	 
which	can	be	accessed	by	right	clicking	over	the	Shape	Detection	icon.

Form	area

This function will find an object on the display from the border of the image to the centre and stop at the first detected contour.

Form	area	margin

This function detects the form area as in the ‘Form Area’ tool but then draws lines around this depending on the settings in the 
pop-up menu. This allows users to easily draw maximum and minimum lines around the form.

Shape	area

This function will find an object on the display from the border of the image to the centre without stopping.

Form	poly	area/Shape	poly	area

These functions are special versions of Form	Area and Shape	Area that automatically transform the object into a Polygon 
Item. The generated polygon(s) have the same properties (edit, add/remove points) than a Polygon Item of the toolbox.

 i The	polygon	transformation	can	also	be	manually	called	from	the	Form	Area	and	Shape	Area	objects:	when	
selected	click	the	left	mouse	button.	The	Template	transformation	is	also	supported.

 i When	using	Form	or	Shape	functions	the	background	and	other	image	features	will	affect	the	performance.	With	
some	subjects	it	may	be	necessary	to	apply	some	image	processing	to	the	image	to	optimise	the	performance	
of	these	features.
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1 .2 .2 Image	processing	functions

 i Only	accessible	when	the	image	has	been	frozen.	These	image	processing	features	are	not	 
available	on	live	video	images.	The	frozen	image	is	not	stored	as	standard.

 X Click on the image processing icon to display its drop down menu (see right). 
 The options are as follows:

Fixed	threshold

This option processes the image to a set threshold.

Threshold

This option allows the image to be processed using an adjustable threshold. When selected, the  
threshold settings icon becomes accessible (see right).

 X Click on the threshold settings icon to display the threshold setting controls (see right).

 X Click and drag the sliders to create the desired image.

Canny edge

This option uses a multi-stage algorithm to detect edges of an image. When selected, the  
threshold settings icon becomes accessible (see right).

 X Click on the threshold settings icon to display the threshold setting controls (see right).

 X Click and drag the sliders to create the desired image.
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Colour	edges

This option uses colour to select edges on the image.

Manual	histogram

This option performs histogram equalization (for a non-uniform image)

Auto	histogram

This option performs histogram equalization with automatic values.

Gamma	and	threshold	levels

This feature allows colour and brightness to be adjusted to pick out details that would be hard to see otherwise.

 X Use the controls on the panel to adjust the gamma and threshold levels to be  
as required.

Threshold	levels

When this option is selected, the window shown right will be displayed.

 X Use the controls on the panel to adjust the threshold levels to be as required.
Auto	segment

This function automatically divides the display image into various segments by reducing  
the number of colours and brightnesses to segment the image.

Voronoi

This option partitions a plane into regions based on distance to points in a specific subset of the plane. That set of points 
(called seeds, sites, or generators) is specified beforehand, and for each seed there is a corresponding region consisting of all 
points closer to that seed than to any other. These regions are called Voronoi cells.
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Despekle

This option is used to remove small defects due to dust, or scratches, from the image.

Invert

This option inverts the colours or turns black to white and white to black.

Blank

This option turns the image white but retains measurement and annotations.

Protanopia

This option allows for the sort of colour blindness that results from insensitivity to red light, causing confusion of greens, reds, 
and yellows.

Deuteranopia

This option allows for the sort of colour blindness that results from insensitivity to green light, causing confusion of greens, 
reds, and yellows.

Tritanopia

This option allows for the sort of colour blindness that results from insensitivity to blue light, causing confusion of greens and 
blues.

1 .2 .3 Crop

 X Click on the crop icon to display a red rectangle on the image.

 X Move the square over the required part of the image and use the white circles on the square’s edges to  
 resize it as required.

 X Click  to crop the image to the size of the square.

 X Click  to return to the uncropped image.
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1. Save options
1.1 Save options icons
The save options section of the Tools tab contains the icons shown below:

Figure 1: Save option icons

• u Save options (see below)

• v Save 

1.2 Save options functions
The save options are set so that when  is clicked on, the same save type will be performed. 

 X Click this icon to display the drop down list of object options (see right).

 X The options are as follows:

1.2.1 Save Doc

With this option set, when the  is clicked, a window will be displayed allowing the user to save a document in a location 
of their choice.

The saved document retains the image, annotation and measurement information for recall later. Annotations and image 
measurements can be edited when reopened.

u v
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1.2.2 Quick Save Doc

With this option set, when the  is clicked, the document will be saved in the documentation location entered in the 
settings window (see help file 13 Settings).

1.2.3 Save Image

With this option set, when the  is clicked, a window will be displayed allowing the user to save the image file with 
annotations burned into it in a location of the user’s choice.

1.2.4 Quick Save Image

With this option set, when the  is clicked, the image file with annotations burned into it will be saved in the image location 
entered in the settings window (see help file 13 Settings).
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1. Calibration

 i Calibration settings can only be set and/or altered by a user logged in as an administrator. 
The default password is ‘admin’

1.1 Calibration tab
When the Calibration tab is selected, the calibration screen is displayed  
(see right).

• u Calibration controls (see page 3 for full details) 
This group of controls enables automatically or manually setting the  
calibration, locking or unlocking calibration settings, saving the calibration  
and refreshing the calibration settings. 

• v Calibration settings (see page 3 for full details) 
These settings indicate the calibrated distance and units being used.

• w This area shows the user details.

• x This area shows details of the calibration file that will be generated.

• y This area shows details of the camera currently in use and key settings as  
  available for each system.

u

v

w

y

x
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1.2 Calibration controls
The Calibration tab contains the controls shown below:

Figure 1: Calibration icons

• u Auto/Manual calibration (see below)

• v Lock/unlock calibration 

• w Save calibration settings

• x Refresh calibration

1.3 Calibration settings
1.3.1 Auto/manual calibration

This function allows either automatic or manual calibration to be carried out.

 X Place the cursor over this icon to display the drop down list (see right).

 X The procedures are as follows:

u

v

w

x
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Auto

 X Place a suitable calibration sheet (e.g. as supplied by Vision Engineering) containing at least one circle of a known 
dimension.

 X Click on the Auto option. The system will place a rectangle around the circle.

 i If the Auto calibration option fails to create a rectangle, an error message will be displayed and a rectangle will 
be placed in the display as in the Manual option (see below).

 X Enter the required units for the calibration from the units drop down list (see right).

 X Click the  icon to the right of the Distance (value) display (see right).

 X This will display the distance entry box (see right).

 X Key in the diameter of the calibration circle and click OK to confirm or Cancel to abort. 

 X When the required dimension has been set, use the lock function to set the calibration (see page 5).

Manual

 X Place a suitable calibration sheet (e.g. as supplied by Vision Engineering) containing at least one circle of a known 
dimension.

 X Click on the Manual option. The system will place a rectangle in the display area.

 X Drag the rectangle over the calibration circle and use the white point to change the size  
of the rectangle to fit the outside of the circle.

 X Enter the required units for the calibration from the units drop down list (see right).

 X Click the  icon to the right of the Distance (value) display (see right).

 X This will display the distance entry box (see right).

 X Key in the diameter of the calibration circle and click OK to confirm or Cancel to abort. 

 X When the required dimension has been set, use the lock function to set the calibration (see page 5).
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1.3.2 Lock/Unlock calibration

After a calibration procedure has been carried out, use this function to lock the calibration settings.

 X Clicking on this icon when a calibration has been carried out locks the camera’s zoom and focus controls  
 so as to retain the calibration settings. This means that any item subsequently viewed by the camera can  
 have its dimensions measured accurately.

 X Click the icon again to unlock the camera controls in order to allow further calibration if required.

1.3.3 Save calibration

 i When saving a calibration first change the calibration name in the field ‘Cal Name’ then  
 save the  settings.

 X Click on this icon to save the current calibration settings.

1.3.4 Refresh calibration

 X Click on the refresh icon to store the current zoom and focus position in the calibration settings.
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1. Library images
This tab allows all the images within a folder to be previewed. It also enables an existing image to be compared with the 
currently displayed image.

1.1 Library image icons
The Library images tab contains the following icons:

Figure 1: Library images tab icons

• u Load images (see 1.2 on page 3)

• v Clear loaded images (see 1.3 on page 3)

 i The library is cleared so that other images can be imported.

• w Insert image (see 1.4 on page 4)

• x Compare with current image (see 1.5 on page 4)

u

v w x
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1.2 Load images

 X Click  to display the load images window (see right). The folder displayed will be the 
location designated using the settings window (see help file 13 Settings). If a different  
folder contains the required images, navigate to that folder.

 X Once the required folder has been selected, click Open.

 X All the images from that folder will be loaded into the preview panel u.

 i Images from multiple folders can be imported into the Library for use in the software. 
A limited number of images can be imported into the library. Once the library is full it will need  
 to be cleared before more images are imported for working.

1.3 Clear loaded images
Click  to clear the images from the Library. 

 i This does not delete the image files.

u
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1.4 Insert image
To place one of the images in the preview panel into the display, proceed as follows:

 X Click on the required image in the preview panel to select it and then click on the Insert image icon. The  
 selected image will be displayed in the display area.

1.5 Compare with current image
To compare an image in the preview panel with the image in the display area, proceed as follows:

 X Click on the required image in the preview panel to select it and then right click  
 on the Compare with current image icon to display the compare options menu  
 (see right).

 X Select one of the following options and then click on the icon again to carry out the  
    selected comparison type:

1.5.1 Matching

This function carries out a strict comparison between the active reference image and the image selected from  
the image panel.

1.5.2 Similarity

This function matches the selected image with the reference image as closely as possible. Matching zones are displayed with 
red dots on the reference image.

1.5.3 Scaled similarity

This function looks for similarities between images that may be the same items at slightly different sizes. If the images are too 
complex (i.e. containing too much detail) the similarity ay not be detected.
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1.5.4 Compare point

This function will match the selected image with the reference image. Matching zones are displayed with red dots on the 
reference image.

1.5.5 Compare filter points

This function works in the same way as Compare point (above) but with a limitation on the number of markers.

1.5.6 Compare 2 images

This function will merge the selected image with the reference image. Matching zones are identified and linked with a line 
between the 2 images. 

1.5.7 Compare filter 2 images

This function works in the same way as Compare 2 images (above) but with a limitation on the number of markers.
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1. Focus stacking
1.1 Focus stacking icons
The Focus stacking section of the tool tab contains the following icons:

Figure 1: Focus stacking icons

• u Load images

• v Run function

• w Delete

The focus stacking tab allows the following functions to be carried out:

• Focus stacking (see page 3) 
This function amalgamates several images of the same object with various points in focus into one  
image totally in focus.

• Composite (see page 4) 
This function forms the loaded images into a strip.

• PanoFocus (see page 5) 
This function takes several images and constructs a single panoramic image.

• PanoFocusCrop (see page 5) 
This function performs in the same way as PanoFocus but crops out the blank areas that are often produced.

u

v

w
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1.2 Focus stacking
To create one focussed image from several images of the same object with different focal points, proceed as follows:

 X Click  to display the load images window (see right). The folder displayed will be the 
location designated using the settings window (see help file 13 Settings). If a different  
folder contains the required images, navigate to that folder.

 X Select the images to process and click Open.

 X The images will be loaded and the last image in the series will be displayed in the  
preview panel u (see right).

 X Clicking the preview arrows v will display each loaded image in turn in the preview panel.

 X Clicking the main display arrows w will display each loaded image in turn on the main display.

 X Select Focus Stacking from the functions drop down menu x if necessary.

 X Click  to create fully focussed image in the main display (see below).
v

u

w

x
Loaded images

Focus stacked image
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1.3 Composite view
To produce a composite image of loaded images, proceed as follows

 X Click  to display the load images window (see right). The folder displayed will be the 
location designated using the settings window (see help file 13 Settings). If a different  
folder contains the required images, navigate to that folder.

 X Select the images to process and click Open.

 X The images will be loaded and the last image in the series will be displayed in the  
preview panel u (see right).

 X Clicking the preview arrows v will display each loaded image in turn in the preview panel.

 X Clicking the main display arrows w will display each loaded image in turn on the main display.

 X Select Composite from the functions drop down menu x if necessary.

 X Click  to create  composite image in the main display (see below). v

u

w

x

Loaded images

Composite view
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1.4 PanoFocus
This function stitches together several images to create a panoramic image (see below).

1.5 PanoFocusCrop
This function behaves in the same way as PanoFocus (see above) but automatically removes the blank (black) areas of the 
image (see below).

 i Note: For best performance of panofocus and panofocuscrop function it is important to ensure there is 
sufficient overlap of the images to be stitched together. Approximately 30% overlap is recommended. Images 
must also include sufficient image detail for registration points to be identified. Panofocus and panofocuscrop 
only work for horizontal image stitching.
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1. Watershed
The Watershed toolbox (for Watershed Segmentation) allows an advanced use of the LASSO tool according to two main 
models: Direct mode and Segmentation Only. The LASSO tool, based on the PolyLine behaviour, enables shape detection 
and automated trimming (points and / or “magnetic” traces).

Figure 1: Watershed tools

• u Lasso tool

• v Automatic segmentation

u v w x

• w Cancel/Undo

• x Refresh

1.1 Direct mode

 X Select the Lasso tool and then left click at least three times in various positions in the background of  
the image to identify it. Then right click and select Direct Mode from the menu (see right).

 X Select the Lasso tool again and then left click at least twice in various positions within an object  
to identify it. Then right click. The area of the object will then be displayed.

 X Repeat the above step for each object to be measured.

 X By clicking on the area outline to select it and then double clicking on it the menu shown right will  
be displayed.

 X Click on Fit to Polygon to display the objects perimeter measurement.
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1.2 Segmentation Only

 X Select the Lasso tool and then left click at least three times in various positions in the background of  
the image to identify it. Then right click and select Segmentation Only from the menu (see right).

 X Select the Lasso tool again and then left click at least twice in various positions within an object  
to identify it. Then right click. The object will be displayed as a coloured block against a background  
in the image panel to the left of the display panel.

 X Repeat the above step for each object to be displayed. See below for an example.

Figure 2: Segmentation example

 X To change any of the colours, double click on the required colour to change in the colour display box u, make the 
changes in the colour selection window and click OK to make the change or Cancel to abort.

u
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1.3 Automatic segmentation
The LASSO tool requires 2 initial traces: the first defines the background and the second the target to be processed which 
is, if the operation is valid, automatically generated under the ShapeArea graphic object type. All other traces are unified 
(unique) and complete the detection.

 i Depending on the image type, this mode may be inappropriate (the operation is not valid) a, in this case the pure 
Segmentation mode must be used.

1.4 Cancel/Undo

 X Click the  icon to cancel or undo a segmentation operation.

1.5 Refresh
This feature updates the calibration view (left panel) with the current Video interface parameters.
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1. General functions
1.1 General functions (file) menu
The general function are accessed through the File menu (see right). These functions can be  
divided into the following:

• About 
This displays a window containing support and version information.

• Loading files u (see page 3) 
This section of the menu enables files to be loaded/imported.

• Saving and printing v (see page 5) 
This section of the menu enables reference images, calibration, tools drawing,  
annotations, calculations and measurements to be saved in various formats. It also  
enables the main display image and the table containing any measurements  
to be printed.

• Export files w 
These options allow the contents of the measurement table to be exported in  
different formats.

• Display control x (see Tools tab) 
This section of the menu enables the display area to be controlled.

• Load previous files y  
This section of the menu allows up to five previous .elv files to be loaded.

• Exit  
This option quits the program but only if the video camera is not operating (i.e.  is clicked).

u

v

w

x

y
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1.2 Loading files

 i .elv files record the image, annotations and measurement data in a format which then allows them to be 
reopened and edited.

1.2.1 Read Doc

When selected, this option displays a folder navigation window enabling the following file types to be loaded:

• .elv

• .dxf

• .png

• .jpg

• .jpeg

• .tif

• .tiff

• .bmp

 X Click on the Read Doc option in the File menu, navigate to the required folder and click on the required file.

 X Click Open to load the file or Cancel to abort.

1.2.2 Import Doc

When selected, this option displays a folder navigation window enabling an .elv file to be loaded.

 X Click on the Import Doc option in the File menu, navigate to the required folder and click on the required file.

 X Click Open to load the file or Cancel to abort.
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1.2.3 GUI Read Doc

When selected, this option displays a window enabling an .elv file to be loaded that includes the main display image and any 
objects and measurements.

 X Click on the GUI Read Doc option in the File menu, navigate to the required folder. A display image and objects will be 
displayed.

 X Click on  to select another folder if necessary.

 X Click  or  to until the required image is displayed.

 X Click Load to load the file or Quit to abort.

1.2.4 GUI Import Doc

When selected, this option displays a window enabling an .elv file to be loaded that includes only objects and measurements.

 X Click on the GUI Import Doc option in the File menu, navigate to the required folder. A display image and objects will be 
displayed.

 X Click on  to select another folder if necessary.

 X Click  or  to until the required image is displayed.

 X Click Load to load the file or Quit to abort.

1.2.5 GUI Read DXF

When selected, this option displays a window enabling .dxf file to be loaded.

 X Click on the GUI Import Doc option in the File menu, navigate to the required folder. A display image of the .dxf file will be 
displayed.

 X Click on  to select another folder if necessary.

 X Click  or  to until the required image is displayed.

 X Click Load to load the file or Quit to abort.
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1.3 Saving and printing

 i .elv files record the image, annotations and measurement data in a format which then allows them to be 
reopened and edited.

1.3.1 Save Doc
When selected, this option displays a folder navigation window enabling an .elv file to be saved.

 X Click on the Save Doc option in the File menu, navigate to the required folder and key in a suitable file name if required.

 X Click Save to save the file or Cancel to abort.

1.3.2 Save Image
When selected, this option displays a folder navigation window enabling an image file to be saved.

 X Click on the Save Image option in the File menu, navigate to the required folder and key in a suitable file name if required.

 X Click Save to save the file or Cancel to abort.

1.3.3 Quick Save Image
When selected, this option updates the open file with any changes.

1.3.4 Save PDF
When selected, this option is used to create a PDF file as follows:

 X Click on the Save PDF option in the File menu and use the controls shown below to create a PDF containing the current 
table contents and display image.

 X u page size, v zoom in/zoom out, w portrait/landscape, x page selection, y page layout, z create file.

1.3.5 Print

When selected, this option is used to print the current table contents and display image.

u v w x y z
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1. Settings
The Settings window (see right) is accessed from the Options drop down  
menu in the menu bar at the top of the display.
The following settings can be adjusted:

• u File location (see below)

• v Display settings (see page 3)

• w Colour settings (see page 3)

• x Misc settings  (see page 4)

• y Report header (see page 4)

• z Extended settings (see page 4)

• { Memory statistics (see page 4)

1.1 File location
This section of the Settings window enables the location to be selected for the following files:

• Documents

• Images

• User information

 X To change the save location for any of the above file types, click the appropriate  icon, browse to the required location 
and click Choose.

 X Click Apply to ensure the change is made.

u

z

v

w

x
y

{
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1.2 Display settings
This section of the Settings window enables the following display attributes to be changed:

• Application style 
Although the default style is viStyle other styles are available from the drop down menu shown right.

• Toolbar style 
Select either Popup or Menus from the drop down menu.

• Report model 
The ‘Save PDF’ option in the File menu creates a report. The different report models include different levels of detail. 
Minimal includes a data table and an image. The standard and custom include the operator name and camera settings 
as well as the data table and image.

1.3 Colour settings

• Object: Click on this square to change the colour of the circles and other shapes generated by the software.

• Grid: Click on this square to change the colour of the grid lines when turned on. 

• Lock: Click on this square to change the colour of the cursor when the user tries to select features that have been 
locked.

• Unlock: Click on this square to change the colour of the cursor when the user tries to select features that are unlocked. 

• Cross: Click on this square to change the colour of the cross hair pointer in the general tools box.

• Mark size: Change this value to set the thickness of the line or point for the annotations.

• Precision: Change this value to set the number of decimal places that are displayed for measurements.
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1.4 Misc settings
JPEG factor: Adjust this value to alter the amount of compression that is applied to a JPEG image. The greater the 
compression the smaller the file size and lower the quality of the image.

Format: Select the image format of saved images from the drop down menu shown right.

1.5 Report header
When Report Header... is clicked on, the window shown right will be displayed.

The information entered into the various fields will be added to any generated PDF report.  
When the Apply button is clicked, the ontents of the window will be stored in  
fileC:\ViPlus\Settings\Report.cfg. If Cancel is selected the entered, information will be lost.

 i This function can only be accessed by an administrator.

1.6 Extended settings
This section of the Settings window enables a user to alter the following:

• Width and height of the grid

• The maximum number of objects that will be found

• The minimum area of an object that will be detected

1.7 Memory statistics
This section is for information only.

 i If not enough memory is available, the performance may be affected.
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